SAFETY INFORMATION

TO REDUCE THE RISK OF FIRE AND ELECTRIC SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.

CAUTION: To reduce the risk of fire and electric shock, do not remove the cover (or back panel) to qualified service personnel.

The lightning flash with arrow head symbol, within an equilateral triangle, is intended to alert the user to the presence of uninsulated "dangerous voltage" within the product's enclosure that may be of sufficient magnitude to constitute a risk of electric shock.

The exclamation point within an equilateral triangle is intended to alert the user to the presence of important operation and servicing instructions in the literature accompanying the appliance.

WARNING: TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, DO NOT EXPOSE THIS APPLIANCE TO RAIN OR MOISTURE.

CAUTION: TO PREVENT ELECTRIC SHOCK, MATCH WIDE BLADE OF PLUG TO WIDE SLOT AND FULLY INSERT.

The apparatus shall not be exposed to dripping or splashing, and no objects filled with liquids, such as vases, shall be placed on the apparatus.

IMPORTANT SAFEGUARDS

In addition to the careful attention devoted to quality standards in the manufacturing of your set-top box, safety is a major factor in the design of every instrument. However, safety is your responsibility, too. This sheet lists important information that will help to assure your enjoyment and proper use of the set-top box and accessory equipment. Please read them carefully before operation and using your set-top box.

Installation

1. Read and Follow Instructions- All the safety and operational instructions should be read before the set-top box is operated. Follow all operating instructions.
2. Retain the Instructions- The safety and operating instructions should be retained for future reference.
3. Heed all Warnings- Comply with all warnings on the set-top box and in the operating instructions.
4. Polarization- Some set-top box are equipped with a polarized alternating -current line plug. This plug will fit into the power outlet, try reversing the plug. If the plug still fails to fit, contact your electrician to replace your obsolete outlet. To prevent electric shock, do not use this polarized plug with an extension cord, receptacle, or other outlet unless the blades can be fully inserted without blade exposure. If you need an extension cord, use a polarized cord.
5. Power Sources- This set-top box should only be operated with the rating specified on the label on the back panel of the set-top box. If you are not sure of the type of power supply used to your home or office, please consult your set-top box dealer or electrician. For set-top box intended to operate from battery power, or other sources, refer to the operating instructions.
6. Overloading- Do not overload wall outlets or extension cords as this can result in a fire or electric shock. overloaded AC outlets, extension cords, frayed power cords, damaged or cracked wire insulation, and broken plugs are dangerous, They may result in a shock or fire hazard. Periodically examine the cord, and if its appearance indicates damaged or deteriorated insulation, have it replaced by your service technician.
7. Power-Cord Protection- Power-supply cords should be routed so that they are not likely to be walked on or damaged by items placed upon or against them, paying particular attention to cords at plugs, convenience receptacles, and the point where they exit from the set-top box. Where the MAIN plug or an appliance coupler is used as the disconnect device, the disconnect device shall remain readily operable.
8. Ventilation- Slots and openings in the case are provided for ventilation to ensure reliable operation of the set-top box and to protect it from overheating. These openings must not be blocked or covered. The openings should never be blocked by placing the set-top box on a bed, sofa, rug, or heat register. This set-top box should not be placed in a built-in installation such as a book case or rack, unless proper ventilation is provided or the set-top box manufacturer's instructions have been followed.

Attachments- Do not use attachments unless recommended by the set-top box manufacturer as they may cause hazards.

The apparatus shall not be exposed to dripping or splashing and no objects filled with liquids, such as vases shall be placed on the apparatus.

The apparatus shall not be exposed to dripping or splashing and no objects filled with liquids, such as vases shall be placed on the apparatus.

Cleanings- Unplug this set-top box from the wall outlet before cleaning. Do not use liquid cleaners or aerosol cleaners. Use a damp cloth for cleaning.

Objects that may touch dangerous voltage points or “short-out” parts could result in a fire or electric shock. Never spill liquid of any kind on the set-top box.

Lightning- For added protection for this set-top box during a lightning storm, or when it is left unattended and unused for long periods of time, unplug it from the wall outlet and disconnect the antenna or cable system. This will prevent damage to the set-top box due to lightning and power line surges.

Service

Servicing- Do not attempt to service this set-top box yourself, as opening or removing covers may expose you to dangerous voltage or other hazards. Refer all servicing to qualified service personnel.

Conditions Requiring Service-Unplug this set-top box from the wall outlet and refer servicing to qualified service personnel under the following conditions:

A. When the power-supply cord or plug is damaged.
B. If liquid has been spilled, or objects have fallen into the set-top box.
C. If the set-top box has been exposed to rain or water.
D. If the video does not operate normally when following the operating instructions, adjust only those controls that are covered by operating instructions. Improper adjustment of other controls may result in damage and will often require extensive work by a qualified technician to restore the set-top box to its normal operation.
E. If the set-top box has been dropped or cabinet has been damaged.
F. When the set-top box exhibits a distinct change in performance- this indicates a need for service.

Replacement Parts- When replacement parts are required, have the service technician verify that the replacements he uses have the same safety characteristics as the original parts. Use of replacements specified by the set-top box manufacturer can prevent fire, electric shock, or other hazards.

Safety Check- Upon completion of any service or repairs to this set-top box, ask the service technician to perform safety checks recommended by the manufacturer to determine that the set-top box is in safe operating condition.

Wall or Ceiling Mounting- The product should be mounted to a wall or ceiling only as recommended by the manufacturer.

Heat- The product should be situated away from heat sources such as radiators, heat registers, stoves, or other products (including amplifiers) that produce heat.

# CONTENTS

## SAFETY INFORMATION

## INTRODUCTION
- Front panel
- Rear panel
- Remote control

## SYSTEM CONNECTION
- General
- Connecting the TV
- Connecting a HiFi System

## GETTING STARTED
- Welcome
- Installation

## OPERATION
- Changing channels
- Access the Electronic Programme Guide (EPG)

## EDIT CHANNEL
- Edit Channel menu
- TV Channel list
- Radio Channel list
- TV Channel Recycle List
- Radio Channel Recycle List
- Delete All

## SYSTEM SETUP
- System setup menu
- Language
- TV System
- Local Time Setting
- Timer Setting
- Parental Lock
- OSD Setting
- Favorite
- Audio Description Setting
- Multiview Setting
- Other

## TOOLS
- Tools main menu
- Information
- Factory Setting
- Software Upgrade
- Automatic Upgrade Setting
- Remove USB device safely

## GAMES
- Game

## REC
- REC main menu
- Media Player
- PVR Information
- PVR Setting

## TIMESHIFT/RECORD
- Timeshift
- Record

## TROUBLESHOOTING

## SPECIFICATIONS
INTRODUCTION

About STB

Front panel

Display
Standby button
Remote sensor
Channel up/down
USB port

Rear panel

RF Loop through for an external device
HDMI output
Down Mix Audio 2 Channel L/R
AC Mains
TV aerial for an external TV aerial
Coaxial Digital Audio
Composite Video

English
Remote control

1 STANDBY (Switch the STB on and standby)
2 RED/GREEN/YELLOW/BLUE Buttons (For interactive function/Submenu function buttons)
3 Search backward/forward
4 PAUSE (Pause/Active timeshift function)
5 PLAY
6 TTX (Open interactive service)
7 SUBTITLE (On/Off Subtitle)
8 Menu (Open and close the menu screen)
9 OK button (Confirm a selection within a menu)
10 Cursor (Cursor: Navigation buttons used to navigate menu's items)
11 FAV (Open the Favorite list)
12 RECORD (Record the TV program)
13 VOL+/- (Volume Up and Down)
14 USB (Enter File Manager)
15 Numeric entry (Enter numeric values and select the channel directly by entering it's number)
16 BACK (Switch to previous channel)
17 MUTE (Turn off/on the volume)
18 Previous/Next
19 STOP (Stop program playback or recording)
20 MEDIA (Enter Recorder menu)
21 AUDIO (Select audio mode and audio track)
22 EPG (Open up Electronic Program Guide Menu)
23 INFO (Press for current channel information)
24 EXIT (Exit from menu)
25 CH+/- (Channel Up and Down)
26 TV/RADIO (Switch between TV and Radio)
SYSTEM CONNECTION

General

There are many different types of TV and other equipment that you can connect to the STB. In this manual you will see some of the most common ways to connect your equipment.

Connecting the TV

Connecting a HiFi system
GETTING STARTED

Welcome

If you use the STB for the first time, the “Welcome” menu appears. Press cursor button to setup the Region, Language, Display Mode and Aspect Mode. Highlight “OK” and press the “OK” button to start channel search.

Installation

1. Press the “MENU” button to enter main menu.
2. Press “UP” or “DOWN” button to highlight “Installation”, press “RIGHT” button to enter the Installation menu.
3. Press “UP” or “DOWN” cursor button to highlight the desired item and press “OK” button to enter the sub-menu.
4. Press “EXIT” button to exit.

Channel Scan

1. Select “Channel Scan”, press the “OK” button to enter the Channel Scan menu.
2. Press cursor button to set Scan mode, Scan Band, Channel No., Frequency, Bandwidth and Network Search, then highlight “Search”, press “OK” button to start channel scan.

Auto Scan

1. Select the “Auto Scan”, press “OK” button to enter the Auto Scan menu.
2. Press the cursor button to set “FTA Only” and ‘ACTION’ then highlight “Search”, press the “OK” button to start auto scan.

LCN

If LCN (Logical Channel Number) Select function is activated, you can’t change the original number of TV channels by scanning.
You can activate/disactivate the LCN function by setting the “LCN” to on/off.
OPERATION

Changing Channels

There are three ways of channel selection - stepping through the channel list, selection by number and from the on-screen channel list.

1. **Stepping through the channel list:**
   To move through the channel list, press the upward arrow or downward arrow key on the remote control.

2. **Selected by number:**
   Enter the channel number directly by pressing numeric buttons, and press the “OK” button to select desired channel.

3. **Selected by on-screen channels list:**
   You can also select the required channel directly from on-screen channel list. This is displayed using the STB’s main menu. See “Edit Channel” in this manual for operation detail.

Accessing the Electronic Program Guide (EPG)

**Accessing the EPG of all channels:**

1. Press “EPG” button to enter EPG menu.
2. Press cursor button to switch between channel list, events schedule of the selected channel and now/next events.
3. Press “Green” button to Timer the events.
4. Press “Red” button to display “Time Bar” menu.
5. Press “INFO” button to display the detail of the events.
EDIT CHANNEL

Edit Channel menu

1. Press the 'MENU' button to enter main menu.
2. Press "UP" or "DOWN" button to highlight 'Edit Channel', press "RIGHT" button to enter the Edit Channel menu.
3. Press "UP" or "DOWN" cursor button to highlight the desired item and press 'OK' button to enter the sub-menu.
4. Press "EXIT" button to exit.

TV Channel list

1. In the Edit Channel menu, select "TV Channel List", press "OK" button to enter TV channel list menu.
2. Press "UP" or "DOWN" button to highlight channel, press the "OK" button to preview the desired TV channel.

Use this menu to favor, lock, skip, move, sort, delete and rename channel.

- Press "FAV" button, then press "OK" button to edit the FAV function.
- Press "color" button, then press "OK" button to edit the corresponding function.

Radio Channel list

1. In the Edit Channel menu, select "Radio Channel List", press "OK" button to enter the Radio Channel list menu.
2. Press "UP" or "DOWN" button to highlight channel press the "OK" button to listen the desired Radio channel.

NOTE: Basically, the operation of "Radio Channel List" is the same as "TV Channel List", but there is one point of difference: In "Radio Channel List" mode, there is no video information, so it will always display Radio's logo in the right side preview window.
EDIT CHANNEL

TV Channel Recycle list

1. In the Edit Channel menu, select “TV Channel Recycle List”; Press "OK" button to enter TV channel Recycle list menu.
2. Press “UP” or “DOWN” button to highlight channel. Then press the “OK” button to preview the desired TV channel.

Use this menu to recycle the channel that has been deleted.

Radio Channel Recycle List

1. In the Edit Channel menu, select “Radio Channel Recycle List”. Then press “OK” button to enter the Radio Channel list menu.
2. Press “UP” or “DOWN” button to highlight channel. Then press the “OK” button to listen the desired Radio channel.

NOTE: Basically, the operation of “Radio Channel Recycle List” is the same as “TV Channel Recycle List”, but there is one point of difference: In “Radio Channel Recycle List” mode, there is no video information, so it will always display Radio’s logo in the right side preview window.

Delete All

1. In the Edit Channel menu, select “Delete All”, press “OK” button. You are asked to input a password (the default password is “1234”).
System setup menu

System setup menu allows us to set Language, TV System, Local Time Setting, Timer Setting, Parental Lock, OSD Setting, Favorite, Audio Description Setting, Multiview Setting and Other.

1. Press the "MENU" button to enter main menu.
2. Press "UP" or "DOWN" button to highlight "System Setup", press "RIGHT" button to enter the System Setup menu.
3. Press "UP" or "DOWN" cursor button to highlight the desired item and press "OK" button to enter the sub-menu.
4. Press "EXIT" button to exit.

Language

This menu allows you to set Language.

TV System

This menu allows us to set Video Resolution, Aspect Mode and Digital Audio Out.

Video Resolution: By Source/By Native/480i/480p/576i/576p/720p@50HZ/720p@60HZ/1080i@50HZ/1080i@60HZ/1080p@50HZ/1080p@60HZ

Aspect Mode: Auto/4:3PS/4:3LB/16:9

Digital Audio Out: LPCM Out/BS Out

Local Time Setting

This menu allows you to set the region and time.

Region: This menu is used for changing the region setting.

GMT Usage: This menu is used to allow setting the usage of GMT.
The options are: By Region/User Define/Off

GMT Offset: This menu is valid only when selected "User Define" in GMT Usage menu.
The GMT offset range is "-11:30 ~ +12:00", increasing half hour progressively.

Summer Time: The options are: On/Off

Date: "Date" and "Time" menus are valid only when selected "Off" in GMT Usage menu.

Time: Press numeric button to input the time.
**Timer Setting**

This menu allows us to set the program timer. You can set 8 timers.

- **Timer Mode**: Off/Once/Daily/Weekly/Monthly
- **Timer Service**: Channel/Record
- **Wakeup Channel**: You can select a desired channel as the wakeup channel.
- **Wakeup Date**: Press numeric button to input date.
- **On Time**: Press numeric button to input the time.
- **Duration**: Press numeric button to input the duration time.

**Parental Lock**

This menu allows you to protect menu and channel, and change the password.

1. In “System Setup” menu, select “Parental Lock” and press “OK” button, you are asked to input a password (the default password is “1234”). After inputting the correct password by pressing numeric buttons, the parental lock menu appears.

- **Menu Lock**: To lock the Edit channel/Installation menu. When you want to enter these menus, you must input the password. You can set menu lock to on/off.
- **Rating Lock**: Off/G/PG/PG13/NC16/M18/R21
- **New Password**: To change the password.
- **Confirm Password**: To confirm the new password.

**OSD Setting**

This menu allows you to set OSD Timeout and OSD Transparency.

- **OSD Timeout**: 1-10
- **OSD Transparency**: To set the OSD transparency to Off/10%/20%/30%/40%.

**Favorite**

This menu allows you to rename the favorite group.

1. In Channel menu, select “Favorite”, press “OK” button to enter Favorite menu.
2. Select desired group, press “OK” button to open the mock keypad. Input letter and numeric one by one by pressing the cursor button and press “OK” button to confirm. After finishing input, highlight “OK” on mock keypad to confirm, you change Favorite group name successfully.
3. Press “EXIT” button to quit the group rename menu.
Audio Description Setting

This menu allows us to set AD Service, Use AD as default and AD Volume Offset:

- **AD Service**: On/Off
- **Use AD as default**: On/Off
- **AD Volume Offset**: -3~3

Multiview Setting

This menu allows us to set Multiview:

1. In "System Setup" menu, select "Multiview Setting" and press "OK" button, you can select your desired item 4+1 Pictures or 3x3 Pictures.
2. After you select your desired item, press "EXIT" button to exit the main menu, then press "BLUE" button to enter multiview.

**Multiview Setting**: 4+1 Pictures/3x3 Pictures

Other

This menu allows us to set LNB Power, Channel Play Type, Beeper and Auto Standby.

- **Antenna Power**: On/Off
  - When "Antenna Power" is selected "On", the STB will provide 5V power to antenna.
  - It will not provide power when selected "Off".
- **Channel Play Type**: All/Free/Scrambled
- **Beeper**: On/Off
- **Auto Standby**: 30Min/1 Hour/2 Hour/3 Hour/Off
  - When there is no command to STB on front panel or via Remote in 30 Min - 3 hours, and no timer event, the STB will enter standby mode automatically.
  - If Off is selected, the STB can’t enter standby mode automatically.
- **Loopthrough In Standby**: On/Off
TOOLS

Tools main menu

① Press the 'MENU' button to enter main menu.
② Press "UP" or "DOWN" button to highlight "Tools", press "RIGHT" button to enter the Tools menu.
③ Press "UP" or "DOWN" cursor button to highlight the desired item and press "OK" button to enter the sub-menu.
④ Press "EXIT" button to exit.

Information

This menu can display some parameters and information about this STB.
① In 'Tools' menu, select 'Information', press "OK" button to open information window.
② Press "EXIT" button to exit.

Factory Setting

This menu allows you to re-set the STB back to factory settings, and clear all existed channels.
① In the 'Tools' menu, select 'Factory Default', press 'OK' button. You are asked to input a password (the default password is "1234").
② A confirmation window is displayed. Select "Yes" to return back to factory settings and clear all channels. Select "No" to cancel back to factory settings.
③ Press "EXIT" button to exit.

Software Upgrade

We offer the function for user to upgrade software version by OTA or by USB.
① Enter "Tools" menu, select "S/W Upgrade by OTA" or "Upgrade by USB", press "OK" button, Software Upgrade menu is shown.
② Press cursor button to select the desired item, then highlight 'Start' and press "OK" button to start upgrade.
③ Press "EXIT" button to exit.

Automatic Upgrade Setting

This menu allows you to set the parameters for automatic software upgrade.
Remove USB device safely

In "Tools" menu, select 'Remove USB device safely'. Press 'OK' button to confirm. Then a window is displayed. Press 'OK' button again.

GAME

Game

This menu allows you to play games.

① Press the "MENU" button to enter main menu.
② Press "UP" or "DOWN" button to highlight "Game", press "RIGHT" button to enter the Game menu.
③ Press "UP" or "DOWN" cursor button to highlight the desired item and press "OK" button to enter the game.
④ Press "EXIT" button to exit.
REC

REC main menu

1. Press the "MENU" button to enter main menu.
2. Press "UP" or "DOWN" button to highlight "REC", press "RIGHT" button to enter the REC menu.
3. Press "UP" or "DOWN" cursor button to highlight the desired item and press "OK" button to enter the sub-menu.
4. Press "EXIT" button to exit.

Media Player

This function allows you to play files from USB port.

1. In "REC" menu, select "Media Player", press "OK" button to enter Media Player menu.
2. First you enter media player window, the highlight is on the USB/HDD device. Press "Down" button to move the highlight to directory and file field.
3. Press ‘1’ button, you can switch TAB between Music/Image/Video/Record.
4. Press "UP" or "DOWN" cursor button to select a desired item, and press "OK" button to play the desired files.
5. Press "EXIT" button to exit.

Music:

‘RED’ button: Press ‘RED’ button to show Play List.
‘GREEN’ button: Move the highlight to the file which you want to add to play list, then press ‘Green’ button to add. It will mark a favorite icon on the file.
‘YELLOW’ button: Press ‘Yellow’ button to add all file of current directory to play list. Press again to delete all file of current directory from the play list.
‘BLUE’ button: Press ‘Blue’ button to enter to edit sub-menu.
‘2’ button: Press ’2’ button to open the sort window. You can sort by Name/Time/Size/Favorite.
‘INFO’ button: Press "INFO" button to set repeat mode. The option is Repeat Folder/Random Folder/Repeat One.
‘EXIT’ button: Return to parent directory.

Image:

‘RED’ button: Press ‘Red’ button to show play list.
‘GREEN’ button: Move the highlight to the file which you want to add to play list, then press ‘Green’ button to add. It will mark a favorite icon on the file.
‘YELLOW’ button: Press ‘Yellow’ button to add all file of current directory to play list. Press again to delete all file of current directory from the play list.
‘BLUE’ button: Press ‘Blue’ button to enter to edit sub-menu.
‘2’ button: Press ’2’ button to open the sort window. You can sort by Name/Time/Size/Favorite.
‘INFO’ button: Press ‘INFO’ button to open image setup
‘3’ button: Press ’3’ button to view image in multi view mode
‘EXIT’ button: Return to parent directory.

NOTE: When you browse pictures, press "RED" button or "GREEN" button, you can view 3D pictures.
This menu allows us to set the PVR Setting.
Press “UP” or “DOWN” cursor button to select desired item, press “LEFT” or “RIGHT” cursor button to change the setting.

- **TimeShift**  AUTO/Pause/Off
- **Timeshift to Record**  On/Off
- **PS Record**  On/Off

---

**PVR Storage Information**

This menu can display some parameters of Removable Disk.

1. In “REC” menu, select “PVR Storage Information”, press “OK“ button to open PVR Storage Information window.

2. Press “EXIT” button to exit.

- **Format**  FAT/NTFS  
  Press YELLOW button to open Format menu. Press "LEFT" or "RIGHT" cursor button to change Disk Mode. Select "OK" to format. Select "Cancel" to cancel.

- **DVR Set**  REC&TMS/Record/Timeshift  
  Press BLUE button to open DVR Set menu. Press "LEFT" or "RIGHT" cursor button to change DVR Type. Select "OK" to confirm. Select "Cancel" to cancel.

---

**PVR Setting**

This menu allows us to set the PVR Setting. Press “UP” or “DOWN” cursor button to select desired item, press “LEFT” or “RIGHT” cursor button to change the setting.

- **TimeShift**  AUTO/Pause/Off
- **Timeshift to Record**  On/Off
- **PS Record**  On/Off
TIMESHIFT/RECORD

Plugging an external Mass Storage Device on the USB port gives you access to Time Shift/Record a broadcast programme.

- Pause a broadcast programme and continue watching it later (Time Shift)
- Record a broadcast programme.
- When the space available on the Mass Storage Device runs out, recording of broadcast programme will stop.

NOTE:
Please use USB 2.0 disk when recording or timeshift. For timeshift and recording feature, you need take bigger size USB pen drive or HDD (>2GB) for recording.

Timeshift

Initiate
- Time Shift can be done in viewing mode by pressing the "PAUSE" button.
- Press "RIGHT" or "LEFT" button to move the cursor to the time you desired to view. Press "OK" button to confirm.

Trickmodes
- During the playback, it is possible to perform the following actions:
  - Press "PAUSE" button to pause the playback
  - Press "FORWARD" button to fast forward the playback
  - Press "BACKWARD" button to rewind the playback

Stop the Time Shift
- Press "STOP" button to stop TimeShift.

Record

Instant record
- In viewing mode, press "RECORD" button to instantaneously start a record on the current channel.
- Press "RECORD" button again for input duration.
- Press "STOP" button to stop recording, then a confirmation window appears. Select "Yes" to stop recording. Select "No" to continue recording.

NOTE:
Please select famous brand USB 2.0 USB HDD or USB stick for Recording and Timeshift, such as SAMSUNG, HITACHI and SONY. Some USB devices may not be supported due to its quality.
In some regions, the digital terrestrial signal may be weak. So it is necessary to use an antenna with built-in amplifier or booster, for watching weak signal channels.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible cause</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standby light not lit</td>
<td>Mains lead unplugged</td>
<td>Check mains lead</td>
</tr>
<tr>
<td></td>
<td>Mains fuse blown</td>
<td>Check fuse</td>
</tr>
<tr>
<td>No signal found</td>
<td>Aerial is disconnected</td>
<td>Check aerial</td>
</tr>
<tr>
<td></td>
<td>Aerial is damaged/misaligned</td>
<td>Check aerial</td>
</tr>
<tr>
<td></td>
<td>Out of digital signal area</td>
<td>Check with dealer</td>
</tr>
<tr>
<td>No picture or sound</td>
<td>No transmission at current channel</td>
<td>Select alternative channel</td>
</tr>
<tr>
<td></td>
<td>Scart/AV is not selected on your TV</td>
<td>Select input source for TV</td>
</tr>
<tr>
<td>Scrambled channel message</td>
<td>Channel is scrambled</td>
<td>Select alternative channel</td>
</tr>
<tr>
<td>No response to remote control</td>
<td>Receiver off</td>
<td>Plug in and turn on plug</td>
</tr>
<tr>
<td></td>
<td>Handset not aimed correctly</td>
<td>Aim handset at front panel</td>
</tr>
<tr>
<td></td>
<td>Front panel obstructed</td>
<td>Check for obstructions</td>
</tr>
<tr>
<td></td>
<td>Hand set batteries exhausted</td>
<td>Replace handset batteries</td>
</tr>
<tr>
<td>Forgotten channel lock code</td>
<td></td>
<td>Re-install channels to cancel channel lock</td>
</tr>
<tr>
<td>Forgotten menu lock code</td>
<td></td>
<td>Contact help line</td>
</tr>
<tr>
<td>The remote control will not operate your STB</td>
<td>(1) The batteries in your remote control need replacing</td>
<td>(1) Replace the batteries</td>
</tr>
<tr>
<td></td>
<td>(2) There is an obstruction blocking the signal path</td>
<td>(2) Check that there is nothing in the way of the path between the remote control and the receiver</td>
</tr>
<tr>
<td>After moving the STB to another room you find you are no longer able to receive digital reception</td>
<td>The broadcast signal is weak (when using in-door antenna)</td>
<td>Readjust the location and alignment of in-door antenna</td>
</tr>
<tr>
<td></td>
<td>There is problem with the signal source from the TV point (when connected to TV point)</td>
<td>Try a direct feed from indoor antenna, or use another TV point</td>
</tr>
</tbody>
</table>
# SPECIFICATIONS

## TUNER & CHANNEL
- **RF INPUT CONNECTOR x1** (IEC-TYPE, IEC169-2, FEMALE)
- **RF OUTPUT CONNECTOR x1** (IEC-TYPE, IEC169-2, MALE (LOOPTHROUGH))
- **FREQUENCY RANGE:**
  - 174MHz~230MHz (VHF)
  - 470MHz~862MHz (UHF)
- **SIGNAL LEVEL:**
  - -15 ~ -70 dbm

## DECODER
- **Video decoder**
- **Audio decoder**
- **INPUT RATE**
- **VIDEO FORMATS**
- **MODULATION**
- **VIDEO OUTPUT**
- **HDMI, CVBS**
- **QPSK, 16QAM, 64QAM, 256QAM**

## CONNECTION
- **MAIN POWER CABLE**
- **TUNER**
- **DATA PORTI**
- **HDMI**
- **SPDIF**
- **RCA OUTPUT**
- **FIXED TYPE**
- **ANTENNA INPUT x1, RF OUTPUT x1**
- **USB slot**
- **HDMI OUTPUT x1**
- **COAXIAL x1**
- **CVBS/R/L x1**

## POWER SUPPLY
- **INPUT VOLTAGE**
- **POWER CONSUMPTION**
- **220-240V~, 50/60Hz**
- **MAX. 12W**

## NOTE:
Design and Specifications are subject to change without notice.

Manufactured under license from Dolby Laboratories. Dolby and the double-D symbol are trademarks of Dolby Laboratories.